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Preface
Purpose
This document describes the Unified CCDM Integrated Configuration Environment (ICE) tool.
ICE is a centralized tool that provides easy access to most of the configuration options available
within the Unified CCDM platform.

Audience
This document is intended for network and system administrators who are familiar with network
services, routing operations and administration.

Organization
This document contains the following chapters:
Chapter 1 Introduction to ICE
Chapter 2 Cluster Configuration
Chapter 3 Replication Manager
Chapter 4 Failover Manager
Chapter 5 Service Manager
Chapter 6 System Properties Manager
Chapter 7 Gadget Provider Manager

Document Conventions
This document uses the following conventions:
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Convention Description
boldface font Boldface font is used to indicate commands, such as entries, keys, buttons, folders
and submenu names. For example:
Choose Edit > Find
Click Finish
italic font

Italic font is used to indicate the following:
To introduce a new term; for example:
A skill group is a collection of agents who share similar skills
For emphasis; for example:
Do not use the numerical naming convention
A syntax value that the user must replace; for example:
IF (condition, true-value, false-value)
A title of a publication; for example:
Refer to the Cisco CRS Installation Guide

window font Window font, such as Courier, is used for the following:

Text as it appears in code or that the window displays; for example:
<html><title>Cisco Systems, Inc. </title></html>
< >

Angle brackets are used to indicate the following:
For arguments where the context does not allow italic, such as ASCII output
A character string that the user enters but that does not appear on the window,
such as a password

Obtaining Documentation and Submitting a
Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a
service request, and gathering additional information, see What's New in Cisco Product
Documentation, at:
http://www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html
Subscribe to What's New in Cisco Product Documentation, which lists all new and revised Cisco
technical documentation as an RSS feed and delivers content directly to your desktop using a
reader application. The RSS feeds are a free service.

Field Alerts and Field Notices
Cisco products may be modified or key processes may be determined to be important. These are
announced through use of the Cisco Field Alerts and Cisco Field Notices. You can register to
receive Field Alerts and Field Notices through the Product Alert Tool on Cisco.com. This tool
enables you to create a profile to receive announcements by selecting all products of interest.

Preface

Log into www.cisco.com and then access the tool at
http://www.cisco.com/cisco/support/notifications.html

Documentation Feedback
To provide comments about this document, send an email message to the following address:
contactcenterproducts_docfeedback@cisco.com
We appreciate your comments.
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Introduction to ICE
About ICE
The Integrated Configuration Environment (ICE) application is a centralized tool that provides
easy access to most of the configuration options available within the Unified CCDM platform.
Individual configuration tools are components within ICE.
The ICE application supplied with Unified CCDM has the following components:
Cluster Configuration
Provides functionality for configuring the network topology used by the Unified CCDM
system. This tool enables configuration of servers, resources (for example, Unified
CCDM components, Unified CCE components) and the connections between them. It
also provides monitoring capabilities.
System Properties Manager
Provides functionality for configuring system wide properties that control a variety of
Unified CCDM components.
Replication Manager
Provides functionality for configuring and monitoring SQL Server replication between
Unified CCDM databases.
Services Manager
Provides functionality for monitoring and controlling all Unified CCDM services across
servers from a single centralized location
Failover Manager
Provides functionality for performing manual switchover of the Data Import and
Provisioning services between two servers.
Custom Dimension Editor
Creates and edits custom dimensions.
ICE is installed as part of the Unified CCDM component installation..
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Using ICE
Starting ICE
1.

Launch Integrated Configuration Environment (installed as part of Unified CCDM). In
the Database Connection dialog box, set:
Server Name. Enter the name of the primary database server.
Database Name. Enter the name of the Unified CCDM database that was installed
when setting up the Database Component. If you accepted the default value, this will
be Portal.
Authentication. Select Windows Authentication.

2.

Click OK. The ICE Cluster Configuration tool starts by default.

3.

If there were errors or warnings in the configuration, then the error details are shown in the
Cluster Configuration Error List pane (see section "Cluster Configuration Error List Pane").

Note
When ICE starts, the Error List pane shows both connection errors and validation errors.
Subsequently, the Error List pane only shows validation errors. But the connection status can be
seen at any time on the Connections page (see section "Connections Page").

ICE Menu and Toolbar
Common actions are visible in the menu and the tool bars at the top of the screen. The common
actions supported by ICE are as follows:
Icon Action

Description

Save

Save any changes.

Exit

Close the ICE application.

Preferences View the ICE tool and component preferences.
View Output View the standard output feedback window.
Undo

Undo the last change.

Redo

Redo the last change.

Introduction to ICE
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Configured actions may be shown in the menu, the tool bar or both. Generally, commonly
used actions (for example, Undo, Redo) are displayed in both the tool bar and the menu, and
less commonly used actions just appear in the menu.
As an example, consider the File action shown in Figure 1.1 "Common File Actions". Save
and Open are shown on both the menu and tool bar, whereas Exit and Preferences are only
shown in the menu. The ICE tool in this example is the System Properties tool.

Figure 1.1

Common File Actions

ICE Tool Selection
The ICE application toolbar contains a drop down list below the menu (see Figure 1.2 "ICE Tool
Selection Drop Down List"). This contains the available ICE tools. To start an ICE tool, select it
from the drop down list.

Introduction to ICE
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ICE Tool Selection Drop Down List

ICE Tool Area
The central area of the ICE application is used by each ICE tool for their own interface. Figure
1.3 "Central Pane for ICE System Properties Tool". shows the central pane for the ICE System
Properties tool.

Introduction to ICE
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Central Pane for ICE System Properties Tool

ICE Output Pane
The bottom area of the ICE application contains an output pane showing the output from the active
ICE tools. This area also contains any additional output panes from specific ICE tools.
If both the ICE output pane and a specific output pane are available, they are shown one on top of
the other, with a tab to select the one that is visible. Figure 1.4 "Output and Error Panes for ICE
Cluster Configuration Tool" shows the ICE output pane and the error list pane from the ICE
Cluster Configuration tool. In this example, the ICE output pane is currently visible.

Introduction to ICE

Figure 1.4
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Output and Error Panes for ICE Cluster Configuration
Tool

You can control the display of the output panes in the following ways:
You can change the height of the whole area by dragging the top edge up or down using the
mouse.
You can close the current pane, by clicking on the cross at the top right of the pane.
You can show or hide any currently available pane from the View menu.
You can control the output that is shown in the ICE output pane as follows:
Click on the Show output from drop down list at the top left of the pane to show output from
one ICE tool or from all ICE tools. In the example in Figure 1.4 "Output and Error Panes for
ICE Cluster Configuration Tool" the output pane is showing the output from the Cluster
Configuration tool only.
Click on the Level drop down list to choose the level of output you want to see. In the
example in Figure 1.4 "Output and Error Panes for ICE Cluster Configuration Tool" the
output pane is showing the information level output messages.

Cluster Configuration
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Cluster Configuration
About Cluster Configuration
Description
The Cluster Configuration tool enables you to configure the Unified CCDM and third party servers
and components in an Unified CCDM deployment. It also enables you to define connections
between these components and specify the connection credentials. The cluster configuration
created using this tool provides individual Unified CCDM components with information about how
to route data within the system.

The Cluster Configuration Model
The Cluster Configuration tool provides a graphical interface over a model that is used as part of
the generic Unified CCDM monitoring component to test and provide connections to all services
in the Unified CCDM platform.
The underlying cluster configuration model consists of the following core objects:
Servers
A server represents a physical computer on the network.
Physical Resource Components
A physical resource component represents a real service running on a server. For
example a ConAPI service or AW Database on an ICM.
Physical Resource
A physical resource is a grouping of physical resource components that all form part of
the same system. For example a Unified CCE system may consist of an AW and a
ConAPI component.
Logical Resources
A logical resource is a grouping of several physical resources that represent replicated
versions of a single system. For example a Unified CCE system may be dual-sided,
consisting of two distinct systems for fault tolerance and redundancy. In this situation
there would be a single logical Unified CCE resource with 2 physical resources
instances, one representing side A and the other representing side B.
Physical Connections
A physical connection represents a link between two physical resource components.
The component being connected to is known as the destination component, and the
component connecting is known as the source component.

Cluster Configuration
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The Cluster Configuration tool supports loading and saving this model from both an Unified
CCDM database and an XML file.

Equipment Mappings
Equipment mappings define mappings between folders and remote equipment which specify where
imported items are placed in the Unified CCDM folder tree. They also control the visibility of
remote equipment and their resources in the user interface.
Equipment Mappings and Importer Behavior
The importer uses the equipment mappings to determine which folder to place new items in. The
folder is chosen by applying the following logic, in order:
If the item being imported is owned by a remote tenant and there is a corresponding
equipment mapping for that remote tenant, the importer chooses the folder defined by the
mapping.
If the item being imported is owned by a remote tenant but there is no corresponding
equipment mapping for that remote tenant, the importer chooses the default import location
folder, if one is defined.
Finally if there is no remote tenant mapping or default import location mapping specified, the
importer chooses the /Unallocated folder within a subfolder folder named after the
equipment, for example, /Unallocated/CICM123.
If an equipment mapping is changed after an initial import, the importer moves existing items to a
new folder based on the logic above in the following scenarios:
If an item is currently in the equipment’s /Unallocated folder.
If an item’s location is no longer synchronized with its remote tenant ownership. See section
"Importing Remote Ownership Changes" for details.
Equipment Mappings and the User Interface
Using a combination of a user’s security permissions and the equipment mappings, it can be
determined which remote equipment the user has the right to access. This is applied when the
equipment is listed in the Unified CCDM web application for example, on the person dimension
edit screen and phone creation screen (Unified Communications Manager drop-down list).
The user has the right to view equipment if there is an equipment mapping to any tenant that
contains any folder that the user has permission to view. For example, if there was a tenant: /t1
and the user had the right to see folder /t1/folder1 and there was an equipment mapping to
/t1/folder2 then the user has right to view the equipment. The user also has the right to view
equipment which only has equipment mappings to folders outside of tenants.
For more information on moving resources through the Unified CCDM web application please
refer to the User Guide for Cisco Unified Contact Center Domain Manager.

Cluster Configuration
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Resource Ownership Principles
Resources in Unified CCDM are owned by tenants. This section describes how this ownership is
managed and the implications of item ownership on the importer.
Unified CCDM Tenant Ownership
Unified CCDM tenant folders contain the items which they own. Moving an item to another tenant
folder automatically changes its owner. Items located outside the tenant folders are not owned by
a specific tenant. Depending on the security settings, these items can be shared between tenants
or hidden from all tenants.
Remote Tenant Ownership
Some Unified CCE items also have an additional level of ownership on the Unified CCE instance.
The Unified CCE equivalent of a tenant is a customer definition, which can be associated with the
following items:
dialed numbers
call types
labels
network VRU scripts
scheduled targets
routing scripts.
These items are therefore capable of being owned by both an Unified CCDM tenant and a remote
(Unified CCE) tenant.
Remote Tenant Mappings
Unified CCDM automatically determines which items belong to which remote tenant based on
their location in the folder tree. An item which is located anywhere under a folder mapped to a
remote tenant will be associated with and owned by that remote tenant.
The remote tenant mappings control two Unified CCDM behaviors:
The folder that remote tenant owned items are placed in by the importer.
How the remote tenant ownership changes when a remote tenant owned item is moved
through Unified CCDM.
Remote tenants are mapped to folders from the Equipment Mappings page (see section
"Equipment Mappings Page".
Changing the Ownership of an Item
An item’s ownership can be changed in any of the following ways:
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moving the item or the folder containing the item to a different Unified CCDM tenant.
moving an item capable of being owned by a remote tenant to a folder located under a
different remote tenant mapping.
changing the remote tenant mapping of an item on the remote equipment (for example,
Unified CCE).
Changing Ownership by Moving Items
Since the ownership of items is governed by where it is located in the folder tree, moving an item
can result in a change of remote or Unified CCDM tenant ownership.
The ownership of an item is calculated from the closest remote tenant mapping above the item in
the folder tree. If moving an item changes this mapping, the remote tenant ownership is updated
and the change is provisioned to the remote equipment.
A change of remote tenant mapping during a move is not allowed if the item is referenced by a
customer specific Unified CCE routing script or has a membership to any other items which also
have a remote tenant mapping. For example, the user cannot move a label out of a folder which
has a remote tenant mapping if it is referenced by a script which has a remote tenant association.
To move the label, it must first be removed from the script or alternatively the script should be
made visible to all customers using the Unified CCE Script Editor.
Provisioning of scheduled targets is not supported, so any move which requires a change of remote
tenant will not be allowed. Likewise if script provisioning is disabled for the Unified CCE, any
move of a routing script that requires a change of remote tenant will not be allowed.
Items owned by remote tenants for which there are no remote tenant mappings will not have their
remote ownership changed unless they are moved into a folder with a different remote tenant
mapping.
Importing Remote Ownership Changes
The Data Import service ensures that any remote tenant owned items are correctly located in the
folder tree according to the configured remote tenant mappings. If a remote tenant owned item has
no corresponding remote tenant mapping, it will be placed in the default import location. If the
remote tenant of an item is changed on the Unified CCE the importer will move the item
according to the defined remote tenant mappings so that the item’s folder location continues to
reflect the correct remote tenant ownership.

Cluster Configuration Tool Reference
Cluster Configuration Actions
The ICE Cluster Configuration tool supports the following ICE actions:
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Icon Action

Description

Save

Save any changes to the currently loaded configuration.

Undo

Undo the last change made to the configuration.

Redo

Redo the last change made to the configuration

The ICE Cluster Configuration tool also has the following additional actions:
Icon Action

Description

Save As
Save As Save the currently open configuration to a database
Database
Save As
File

Save the currently open configuration to an XML file

Refresh

Refresh the configuration from the current connection
(database or file)

Validate

Validate the current configuration, and display any
validation errors in the Error List pane.
Note: Validate does not check connection errors,
although the Error List pane does include connection
errors at startup. If any connection errors were shown in
the Error List pane, they will be cleared when you select
Validate.

Open
Open
Open configuration from a database
Database
Open File Open configuration from an XML file
Create
Create a checkpoint in the current configuration. Allows
Checkpoint all changes from a given point to be easily reverted.
Revert To Revert the state of the configuration to the last
Last
checkpoint, reverting and clearing all changes since the
Checkpoint checkpoint.

Cluster Configuration Preferences
The ICE Cluster Configuration tool has the following additional preferences:
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Preference Description
Name
General:
Advanced
Mode

Indicates if the current user should be shown advanced properties on
the cluster configuration objects within the user interface. This
option is not required for day-to-day operations.

General:
Indicates the rate in seconds at which the connection monitoring
Connection system will check the backing store for connection state changes.
Default is 5 seconds.
Monitor
Refresh
Period
The preferences configuration pane is shown in Figure 2.1 "Cluster Configuration General
Preferences User Interface" below.

Figure 2.1

Cluster Configuration General Preferences User
Interface

Cluster Configuration Filters
Some of the Cluster Configuration pages support a filter function to limit the number of items
shown according to a user-specified filter. To access the filter, where available, click Show
Filter (
).
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The actual filters that you can specify depend on the Cluster Configuration page. Within the filter
area, click Clear Filter (
) to clear any filters you have specified and click Hide Filter (
)
to hide the filter options.
The following Cluster Configuration pages support a filter:
Servers page
Connections page
Resources page.

Cluster Configuration User Interface
When you run the Cluster Configuration tool for the first time you are automatically connected to a
model using the shared Unified CCDM relational database connection. You are prompted for
credentials to connect to the Unified CCDM relational database.
Once connected, you will see the initial screen shown in Figure 2.2 "Cluster Configuration Initial
Interface".

Figure 2.2

Cluster Configuration Initial Interface

On the left hand side of the main interface there is a navigation menu that allows easy switching
between the various configuration pages within the tool. These configuration pages include:

Cluster Configuration
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Setup. Contains high-level wizards that are designed to make day-to-day configuration
changes quick and easy.
Servers. Allows physical servers within the model to be added, removed or updated.
Resources. Shows the logical resources, physical resources, and physical resource
components configured within the model. These items can be added, removed, or updated
here.
Equipment Mapping. Only enabled when connected to an Unified CCDM database.
Enables you to create tenants and folders in Unified CCDM and to map equipment like
Unified CCE systems to folders for import and provisioning.
Connections. Allows Unified CCDM component connections to be viewed and edited.

Cluster Configuration Error List Pane
The Cluster Configuration has an additional output pane, the Error List pane (see Figure 2.3 "The
Cluster Configuration Error List Pane"). Click the Error List tab to view the errors and warnings
from Cluster Configuration tool. You can click on the error details to see more information about
an error.
Initially, this pane shows the connection errors and warnings (if any) and validation errors and
warnings (if any) that were detected at start-up. Click Save or Validate to update the contents of
the Error List pane with the current validation errors and warnings.
Note
When you click Save or Validate, any connection errors and warnings are cleared from the Error
List pane. You can view connection problems at any time on the Connections page (see section
"Connections Page").
You can click on the buttons at the top of the error pane to choose the type of error you want view.
In the example in Figure 2.3 "The Cluster Configuration Error List Pane", errors and warnings
have been selected for display, but messages have not been selected for display.
See section "ICE Output Pane" for general information about showing and hiding output panes.

Cluster Configuration
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The Cluster Configuration Error List Pane

Setup Page
For information about the Setup page in the Cluster Configuration tool, see the Installation and
Configuration Guide for Cisco Unified Contact Center Domain Manager, Unified CCDM
Configuration chapter, Configuring the Unified CCDM Cluster section, Setting Up the Unified
CCDM Servers subsection.

Servers Page
The Servers page within the Cluster Configuration tool enables physical servers within the Unified
CCDM deployment to be added, removed or updated.
The Servers page is shown in Figure 2.4 "Cluster Configuration Servers Page".

Cluster Configuration
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Figure 2.4

Cluster Configuration Servers Page

The Servers page consists of a left and right pane. The left hand pane contains a list view
displaying all of the servers configured in the open model. The right hand pane is a property
grid that displays the details of the currently selected server within the list view.
Server objects support the following properties:
Property Advanced Description
Name
Default
Address
Display
Name

The default address that will be used when services within the Unified
CCDM deployment connect to this server. This may be a host name or IP
address.
P

A name used to represent this object when it is referred to in logs,
performance counters etc.

Cluster Configuration

26

Property Advanced Description
Name
Enabled

Indicates if this server is enabled. This is a calculated field and actually
indicates whether all physical resource components on this server are
enabled. Changing this value will update the enabled flag of all physical
resource components on this server.
P

Id
Server
Name

System

A unique ID used to represent this object on the backing store.
The machine name for this server. This is used to identify an Unified
CCDM service’s machine within the cluster model and should match the
value returned by SQL server using @@SERVERNAME or SYSTEMPROPERTY
(‘MachineName’). Viewing Computer properties on a Windows based
computer and looking at the “Computer Name” property can typically find
the correct value.

P

Indicates if the Unified CCDM system installers created this object.

Click Add New within the list view to add a new server to the model . Clicking this will
automatically create a new server in the model and select it ready for editing.
Right-click in the Servers page to see a shortcut menu with the following functions:
Icon Action
Add Server

Description
Add a new server to the model.

Remove Server Remove the selected server from the model.
View

Change the display style of the list view.

The Servers page includes a filter which enables you to filter by server name or address. Click
Show Filter (
) to expand the filter area if it is not currently shown.

Resources Page
The Resources page within the Cluster Configuration tool enables logical resources, physical
resources, and physical resource components within the model to be added, removed or edited.

Cluster Configuration
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Cluster Configuration Resources Page

The Resources page consists of a left and right pane, very similar to the layout of the
Servers page. The left hand pane contains a list view displaying all of the logical and
physical resources configured in the open model. The right hand pane is a property grid that
displays the details of the currently selected object within the list view.
The Resources page includes a filter which enables you to filter by resource group type, resource
type, server or resource name. Click Show Filter (
currently shown.

) to expand the filter area if it is not

The list view on the Resource page contains multiple groups. Each group represents an
individual logical resource within the model. Within each group there will be one or more
items, each representing a physical resource within that logical resource. This structure is
highlighted in Figure 2.6 "Example Logical Resource List View Group".

Cluster Configuration
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Example Logical Resource List View Group

Logical Resources
You can select an logical resource by clicking on the group header text (for example, the text:
Provisioning Server [Provisioning Service] (2) in the example of Figure 2.6 "Example Logical
Resource List View Group"). Selecting a logical resource displays its properties in the property
grid pane, as shown in Figure 2.7 "Property Grid View for Logical Resource".

Figure 2.7

Property Grid View for Logical Resource

The property grid for a logical resource has two tabbed sections; General and Specific. The
General tab contains properties that are common to several logical resources. The Specific tab
contains properties that relate to the specific type of logical resource that has been selected.

Properties of Logical Resources
Logical resource objects may support the following basic properties (through the General tab):

Cluster Configuration
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Advanced Description

Cache
Enabled
Resource
Types

The resource types that will be cached by this server to enhance
performance (applies to App/Web server only).

Child
Resources

The logical resources in the system that are children of this resource.

Default
Import
Enabled
Resource
Types

The resource types that will be imported by default. This can be
overridden on a specific item of remote equipment if required (applies
to Data Import Server only).

Description

A short description of the logical resource.

Display
Name

P

Enabled

Id

A name used to represent this object when it is referred to in logs,
performance counters etc. (Read-only)
Indicates if this logical resource is enabled. This is a calculated field
and actually indicates whether all physical resources in this logical
resource are enabled. Changing this value will update the enabled flag
of all physical resources in this logical resource.

P

A unique ID used to represent this object on the backing store. Read
only.

Import
Enabled
Resource
Types

The resource types that will be imported from this item of remote
equipment (applies to remote equipment objects only). The settings
here override the settings in Default Import Enabled Resource Types.
When a default setting is overridden for a resource type, that resource
type is shown in bold.

Name

A unique name for this logical resource.

Parent
Resources

The logical resources in the system that may be considered to be
parents of this resource.

Provisionable

Whether provisioning has been enabled for this logical resource
(applies to remote equipment only).

System

P

Whether this object was created by the system installers. Read only.

Version

P

The source system version for this logical resource.

The derived logical resource properties for the standard built in resource types are as follows:
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Cisco CICM
Property
Name

Advanced Description

Active
Directory Path

The active directory location from which users can be selected to
provide supervisors with WebView login credentials. (Only shown
if a ConAPI component is configured for the physical resource)

Deployment
Type

The deployment type for this CICM.

Domain
Password

The password to use when connecting to active directory if "Secure
Authentication" has been specified. (Only shown if a ConAPI
component is configured for the physical resource)

Domain User
Name

The user to impersonate when connecting to active directory if
"Secure Authentication" has been specified. (Only shown if a
ConAPI component is configured for the physical resource)

Last Dimension P
Import Config
Change Date

The value of the ControllerConfigChangeTime field in the
AWControl table on the AW the last time a dimension import ran for
this resource. (Read-only)

Last Member
Import Config
Change Date

P

The value of the ControllerConfigChangeTime field in the
AWControl table on the AW the last time a member import ran for
this resource. (Read-only)

Multi Media
Enabled

Indicates if multimedia reskilling is supported for this CICM. (Only
shown if a ConAPI component is configured for the physical
resource)

Person
Minimum
Password
Length

The minimum password length configured for this ICM. (Read-only)

Primary Domain
Server

Primary domain server for active directory access. (Only shown if a
ConAPI component is configured for the physical resource)

Purge Items on
Delete

Indicates if items should be automatically purged on delete (or only
marked for delete) on ICM. (Only shown if a ConAPI component is
configured for the physical resource)

Script Lock
User Name

User name for use when locking routing scripts for edit. (Only
shown if a ConAPI component is configured for the physical
resource)

Script
Provisioning
Enabled

Indicates if script provisioning is enabled for this ConAPI resource.
(Only shown if a ConAPI component is configured for the physical
resource)

Secondary
Domain Server

Secondary domain server for active directory access. (Only shown
if a ConAPI component is configured for the physical resource)
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Advanced Description

Secure
Authentication

Indicates whether a specific user should be impersonated when
contacting to active directory. (Only shown if a ConAPI component
is configured for the physical resource)

Time Zone

The timezone for the ICM.

Time Zone
Display Name

Display name for the ICM timezone. (Read-only)

Data Import Server Service
Property Name

Advanced Description

Import Cycle Delay P

The minimum delay between import cycles (in minutes).

Physical Resources
You can select an individual physical resource by clicking on physical resource in the list view
(for example, the text: Provisioning Server 2 in the example of Figure 2.6 "Example Logical
Resource List View Group"). Selecting a physical resource displays its properties in the right
hand property grid pane, as shown in Figure 2.8 "Property Grid View for Physical Resource".

Figure 2.8

Property Grid View for Physical Resource
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The property grid for a physical resource is broken into three tabbed sections; General, Specific,
and Components. The General tab contains properties that are common to all physical resources.
The Specific tab contains properties that relate to the specific type of physical resource that has
been selected. The Components tab displays details for each of the physical resource components
associated with the currently selected physical resource.

Properties of Physical Resource Objects
Physical resource objects support the following basic properties (through the General tab):
Property Advanced Description
Name
Display
Name

P

Enabled

Id

A name used to represent this object when it is referred to in logs,
performance counters etc. (Read-only)
Indicates if this physical resource is enabled. This is a calculated field and
actually indicates whether all physical resource components in this
physical resource are enabled. Changing this value will update the enabled
flag of all physical resource components in this physical resource.

P

A unique ID used to represent this object on the backing store. (Readonly)

Is
Publisher

Indicates if this physical resource is considered a publisher for replication
within the logical resource.

Name

A unique name for this physical resource.

System

P

Indicates whether this object was created by the system installers (readonly).

Derived, resource type specific properties are exposed through the Specific tab of the property
grid. The derived physical resource properties for the standard built in resource types are as
follows:
Application Server Service
Property
Name
Notification
Enabled

Advanced Description
Indicates if this application server is responsible for raising resource
notification events.
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Data Import Server Service
Property Name

Advanced Description

Last Import End

P

The time when the last dimension import cycle ended.
(Read-only)

Last Import Exception
Count

P

The number of errors that occurred on the last import cycle.
(Read-only)

Last Import Start

P

The time when the last dimension import cycle started.
(Read-only)

Last Import Type

P

The type of the last import cycle. (Read-only)

Relational Database
Property Name

Advanced Description

Prefix Management
Enabled

Whether this database server is responsible for running the
prefix management scheduled job.

Purge Enabled

Whether this database server is responsible for running the
purge scheduled job.

Scheduling Enabled

Unused.

The Components tab on the property grid displays the properties for all physical resource
components that belong to the selected physical resource.
The following table lists the component types supported and required for each of the built-in
physical resource types:
Physical
Resource Type

Component Required
Type

Application Server Default
Service

P

Cisco Call
Manager

Default

P

Cisco CICM

AWS

P

ConAPI
Cisco CVP Call
Server

Default

Description

The Admin Workstation component. Used for
dimension/member import.
The Cisco ConAPI server. Used for
provisioning changes to CCE.

P
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Component Required
Type

Data Import Server Default
Service

P

Partitioning Service Default

P

Provisioning
Service

Default

P

Relational
Database

Default

P

Description

Properties of Physical Resource Components
All physical resource components support the following properties:
Property
Name

Advanced Description

Application P
Name

Application name used for this component when it is the source of a
SQL connection. Can be used to identifier this resource in a SQL
profile. (Read-only)

Display
Name

P

A name used to represent this object when it is referred to in logs,
performance counters etc. (Read-only)

Id

P

A unique ID used to represent this object on the backing store. (Readonly)

Inbound
Connections

All connections to this component from other systems.

Outbound
Connections

All connections from this component to other systems.

Server

The server on which this component resides.

System

Indicates whether this object was created by the system installers.
(Read-only)

In addition, the following derived properties are supported:
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Cisco CICM: AWS
Property Advanced Description
Name
Catalog

The database catalog name.

Custom
P
Connection
Test

SQL query containing custom connection test logic for this component.
The query should return a single row with a BIT column indicating the
state of the component.

Provisioning Service: Default
Property
Name

Advanced Description

Additional
Java Virtual
Machine
Options

All additional options that should be passed to the hosted Java Virtual
Machine. The -Xrs option will be automatically passed in and does
not need to be specified here.

Java Debug
Port Number

The port number to use for connecting the remote debugger when
Java debugging is enabled.

Java
Debugging
Enabled

Enable or disable debugging support in the hosted Java Virtual
Machine.

Java RMI
Server
Hostname

The value of this property represents the host name string that should
be associated with remote stubs for locally created remote objects, in
order to allow clients to invoke methods on the remote object.

Relational Database: Default
Property Advanced Description
Name
Catalog

The database catalog name.

Custom
P
Connection
Test

SQL query containing custom connection test logic for this component.
The query should return a single row with a BIT column indicating the
state of the component.

Logical resources, physical resources and physical resource components may be added/removed
from the model via a context menu that can be accessed by right-clicking on the main list view
area.
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Connections
Connections can be created between two physical resource components within the cluster
configuration model. Components may support inbound connections (that is other components may
connect to them), outbound connections (that is, they can connect to other components) or both
inbound and outbound connections. Each physical resource component type has a connection type
associated with it that defines how other components should connect with it.
Unified CCDM supports the following connection types:
Connection
Type

Description

Cisco ConAPI

Provides support for connections to a Cisco CMS JServer using the ConAPI
Java RMI layer.

Microsoft SQL
Server

Provides support for connections to a Microsoft SQL Server database.

Web Service

Provides support for connections to a web service endpoint.

Connections can be added, removed or updated by clicking on the “Inbound Connections” or
“Outbound Connections” property on a component entry in the property grid. To edit connections
from the selected component to other components use the “Outbound Connections” property. To
edit connections to the selected component from other components use the “Inbound Connections”
property. These properties are only visible on components where connections are supported.
For example, to edit outbound connections for a provisioning server:
1.

In the list view, select the required provisioning server.

2.

In the property grid pane, click on the Components tab.

3.

Click on the Outbound Connections property (see Figure 2.9 "Example Connection
Editing").
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Example Connection Editing

Click on the ellipsis beside the Outbound Connections property. This displays the Manage
Outbound Connections From dialog box, as shown in Figure 2.10 "Manage Outbound
Connections Dialog Box".

Figure 2.10

Manage Outbound Connections Dialog Box

The Manage Outbound Connections dialog box has two main panes. The left hand pane contains a
tree view showing all the components that are available to connect to or from. The tree view
groups all the available components by physical component type and logical resource. An example
of this is shown in Figure 2.11 "Connection Edit Dialog Tree View".
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Connection Edit Dialog Tree View

When a connection exists to a component instance, the icon on the component is highlighted in
green. When no connection exists, the icon is grayed out.
Within each logical resource grouping, the component instances in the logical resource are listed
in order of cost. The cost of a connection is an indication of the resources it has available to it and
how well it will perform – connections with a lower cost can be expected to perform better than
connections with a higher cost. For example, it may be more efficient to make a connection to a
server that is co-located with the server requesting the connection than to make a connection to a
server in another country. In this case, you would define the local server as having a lower cost
than the server in another country.
Unified CCDM will use the lower cost connection if it is available. For example, if a Provisioning
server was connected to a dual sided database then one of the two sides would be the preferred
(lowest cost) connection and the other would be the redundant (highest cost) connection.
To change the relative cost of connections, select a component in the tree view and click the up or
down arrow at the bottom right of the pane to reduce or increase the cost, as shown in Figure 2.12
"Changing the Relative Cost of Connections".
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Changing the Relative Cost of Connections

When a component is selected in the tree view, the right hand pane will automatically populate
with the details for the connection. The connection details pane is broken into three sections; a
common header, a connection type specific properties page and a generic footer. An example for
a SQL connection is shown in Figure 2.13 "Connection Details Pane".
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Connection Details Pane

The common header consists of the following:
Column Meaning
Connected Indicates if a connection exists to the selected component. Checking this box creates a
connection. Clearing this box deletes the connection.
Enabled

Indicates if this connection is enabled. Disabled connections will not be used by the
Unified CCDM monitoring service.

Override By default, the host name for the server on which component resides will be selected
Default from the server objects Default Address property. However, there may be situations
Server
where the actual host name used for a specific connection between two components
needs to be altered (for example when using network address translation). In these
situations, the host name can be set by checking the Override Default Server box and
entering the new host name in the Address field.
The middle pane contains connection type specific properties. For example, when editing a SQL
connection this pane contains settings for the authentication mode and database catalog etc. For
web service connections it will prompt for a URL.
The common footer contains a single Test button. Clicking this button will test the connection
using the details provided in the details section.
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Note
Connections are tested within the context of the ICE application so tests may provide inaccurate
results. When the connections are used by the Unified CCDM system they will be created on
remote servers and subject to any firewalls, network address translation or environment issues
that may exist on those servers. The connections will also be established using the windows
credentials of the service rather than the credentials being used to run the ICE application.

Equipment Mappings Page
The Equipment Mapping tab of the ICE Cluster Configuration tool enables you to create Unified
CCDM tenants and folders, and to specify the way that resources on the contact center are
mapped to Unified CCDM.
The Equipment Mappings page is divided into three vertical sections.
Folder Tree section
Source Equipment section (shown when an item is selected in the folder tree)
Association Options section (shown when an item is ticked and highlighted in the source
equipment section).
To configure your equipment mapping, in the Cluster Configuration tool, select Equipment
Mapping in the left hand navigation pane.
Folder Tree Section
This section enables you to create new tenants and folders in the Unified CCDM Folder Structure.
To create a new tenant or a folder, right-click on the location in the tree where you would like to
create the item and select Add Tenant or Add Folder.
Note
Tenants can only be created under the root folder. Folders can be created anywhere in the tree. A
Tenant is a special folder that maintains ownership of an item. For example, in a hosted
environment, the host’s customers map directly to individual tenants, each of which is assigned
their own individual resources, for example, Agents, Teams, Call Types etc.
Right clicking and selecting the Refresh option will refresh the folder structure from the database,
reflecting any changes that may have been made through the Unified CCDM web application.
Source Equipment Section
This section lists all the configured source equipment. If none are configured then this list will be
empty and you will not be able to do any associations.
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When you select one of the items of configured equipment in the list, you will see options to map
the resources belonging to that equipment to the selected folder in the Association Options
Section.
Association Options Section
This section offers a list of association options between the folder or tenant in the folder tree and
the source equipment. There are two types of association options.
Default Import Location. All resources from the highlighted contact center equipment will be
imported into the selected folder or tenant in Unified CCDM.
Customer Resource Mapping. Allows more control over the import process. You can
specify the items on the highlighted contact center equipment to be placed in the selected
folder or tenant in Unified CCDM. If you select this option you can:
Click
to add a new customer resource mapping that defines the resource types and
the specific resources of that type to be mapped to the selected import location. Select
the resource type from the Type drop-down list (one of Peripheral, Routing Client,
Media Routing Domain and Remote Tenant) then select the specific item of that type
that you want to map from the Resource drop-down list. Click OK. Repeat to map
other customer resources on this item of contact center equipment to the specified
import location.
Click

to delete an existing customer resource mapping.

If Customer Resource Mapping is selected then any resources on the contact center equipment
that are not associated with the selected mapping will be placed in the source equipment subfolder
under the Unallocated folder.
Note
If you want to use the customer resource mapping option, you will not be able to configure this
until you have imported the customer resources you want to use to define the mappings.
In this case, for the first import, do not select the Default Import Location option, as once you
have selected this, the items from the remote equipment will be imported to that location and
cannot be re-imported. Instead, for the first import, do not specify any import location, so
everything is imported into the /Unallocated folder. Once the customer resources have been
imported, you can specify the customer resource mapping you require, and the items in the
/Unallocated folder will be moved to the required locations.
Note
The Customer Resource Mapping is currently only valid for Cisco Unified CCE Resources.
The list is populated with all the customer definitions available on the selected Cisco Unified
CCE resource.
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When you have completed your changes to equipment mappings, click the Save icon in the toolbar
to save your changes.

Connections Page
The Connections page within the Cluster Configuration tool enables all configured connections in
the system to be edited and monitored.
The Connections page is shown in Figure 2.14 "Cluster Configuration Connections Page".

Figure 2.14

Cluster Configuration Connections Page

The Connections page consists of a resizable top and bottom pane. The top pane is the connection
status monitor and shows the status of all the connections configured in the open model. The
bottom pane displays the details for the currently selected connection in the list view.
Each row in the connection status monitor has the following columns:
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Column

Meaning

Status

An icon representing the status of the connection. The following
options exist:
Available
Unavailable
Disabled

Source Server

The name of the physical server that this connection is being
established from.

Source
The display name for the physical resource component type that
Component Type this connection is being established from.
Destination
Server

The name of the physical server that this connection is being
established to.

Destination
The display name for the physical resource component type that
Component Type this connection is being established to.
Click the column headers in the connection status grid to sort the view by the selected column.
Click on an entry in the grid (a source or destination server, or a source or destination component
type) to go to the details for that item.
The row headers on the connection status grid may optionally show an alert icon ( ) if there is a
potential problem with the connection. Hovering over the alert icon will display a tool tip
explaining the reason for the alert. The most common cause of an alert being displayed is to
indicate that the connection status has not been updated for more than 5 minutes. This usually
indicates that the source service is not running or is failing to connect with the Unified CCDM
database. The source service log files should be used to investigate the cause of the problem.
To show the server details for a particular connection, hold down Ctrl and click on the
connection.
To maximize the status monitor and show the Details and History tabs, click on the expand icon
on the splitter bar (see Figure 2.15 "Connection Monitor Full Screen Mode").
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Connection Monitor Full Screen Mode

Connection status is automatically refreshed from the database. By default the status is refreshed
every 5 seconds but this can be modified via the Cluster Configuration preferences (see section
"Cluster Configuration Preferences").
The Connections page includes a filter which enables you to filter by resource type, component
type and server, for both the connection source and the connection destination. Click Show Filter
(

) to expand the filter area if it is not currently shown.

Diagnostic Portal Support
The ICE Cluster Configuration tool enables you to access the diagnostic portal and view
diagnostic logs for the Unified CVP, Unified CCE and Unified CCDM servers.
To view the logs for a server:
configure the diagnostic portal for the server (you only need to do this once)
select the required log and logging period to access the required logs.
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Configuring the Diagnostic Portal
To configure the diagnostic portal for a server:
1.

On the server you want to configure, identify a user name and password for an authorized
user of the Diagnostic Framework. This user must be a trusted domain user in the CONFIG
domain security group of the server being configured.

2.

In the ICE Cluster Configuration tool, select the Resources tab.

3.

Click on the server for which you want to configure the diagnostic portal.

4.

In the right hand pane, select the Components tab.

5.

Set the Diagnostic Portal User Name and Diagnostic Portal Password fields to the user
name and password of the authorized user you identified above.

6.

Select File >Save or click the Save icon in the toolbar.

Note
For more information about the diagnostic portal see Serviceability Best Practices Guide for
Cisco Unified ICM/Unified CCE & Unified CCH, Chapter 10, Unified ICM/Unified CCE
Diagnostic Tools.
Accessing the Diagnostic Logs
To access a diagnostic log:
1.

Right click on the server instance and from the context menu, select Components, then the
component, then one of:
View Logs to view the logs
View Trace Logs to view the trace logs.

2.

The Diagnostic Logs window is shown. In the Diagnostic Logs window, select the type of
log you want to view from the drop down list in the top left of the window.

3.

Specify the From Date and To Date to filter the results by a date range, then click Fetch
Result to get a list of all available logs of that type within the selected date range.

4.

The bottom left pane may show the logs that match the filter, or may show servers or folders
containing logs that match the filter. Double click on the server or folder to view the contents
of that item and drill down to the log files. When you locate the log file you want to view,
double click on the log file to view the contents in the Raw Data tab of the right hand pane.
For CSV log files, you can also select the CSV tab of the right hand pane to view the log file
in CSV format.
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Note
To view diagnostic logs, you must previously have configured the diagnostic portal for this server
as described above.
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Replication Manager
About Replication Manager
The Unified CCDM Replication Manager enables you to manage SQL Server Replication
between Unified CCDM databases.
The Replication Manager has two modes:
Setup: Used to configure and disable SQL Server replication between the Unified CCDM
databases.
Monitor: Used to monitor general health of configured replication, at to start and stop
replication agents.
The Replication Manger should typically be run on the Unified CCDM database publisher (side
A) server. The user running the tool must be a Windows administrator on all the servers that take
part in replication.
Note
To use the Replication Manager, the Unified CCDM database must be configured as dual sided.

The Replication Manager Setup Tab
About the Replication Manager Setup Tab
The Replication Manager Setup tab enables you to configure or disable SQL Server Replication. It
shows the configured Unified CCDM primary database and the distributor server properties.
The initial configuration is derived from the values set in ICE Cluster Configuration. If any of the
values are modified, the configuration must be saved before replication setup can continue.

Unified CCDM Database Server Properties
This section shows the publisher and subscriber Unified CCDM databases. The following
information is available:
Publisher. The publisher database.
Server Name. The name of the Database Server. This is fixed and cannot be changed
using the ICE Replication Manager.
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Catalog Name. The name of the Unified CCDM database. It is recommended that the
default value is used, but if the name is modified, then an Unified CCDM database
with the new name must already exist on the corresponding database server.
Subscriber. The subscriber database.
Server Name. The name of the Database Server. This is fixed and cannot be changed
using the ICE Replication Manager.
Catalog Name. The name of the Unified CCDM database. It is recommended that the
default value is used, but if the name is modified, then an Unified CCDM database
with the new name must already exist on the corresponding database server.

Distributor Properties
This section shows the SQL Server Replication distributor properties. By default the distributor is
created on the subscriber Unified CCDM Database Server. In most cases the default values are
valid and should be used.
The following information is available:
Server Name. The name of the subscriber server hosting the database as configured using
ICE Cluster Configuration.
Catalog Name. The name to be assigned to the distribution database. The recommended
default is distribution_portal.
Override Distributor Admin Password. Select to override the auto-generated replication
password which will be used to establish connectivity. The auto-generated password is 14
characters long, and will contain alpha-numeric characters (both upper and lower case) and
a special character. If this does not meet the complexity requirements of the server then
select this option and specify a password of your choice.
Note
This password is a one-off password used to set up replication. It is not stored and does not
need to be recorded by the user.
Data Folder. The folder path on the distributor server where the data file for the distribution
database will be created.
Note
If you are setting up replication after performing an upgrade, be particularly careful with
the Data Folder path, as it may be different from the value used in previous versions. Make
sure you use the path that was specified when the database was set up.
Log Folder. The folder path on the distributor server where the transaction log file for the
distribution database will be created.
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Distribution Share. The distribution share folder where replication snapshot files will be
generated.

The Replication Manager Monitor Tab
About the Replication Manager Monitor Tab
The Monitor tab shows the replication status and information about the data that is being copied
from the publisher to the subscriber. It enables you to monitor the general health of the replication.
It can also be used to start and stop various replication agents.

Monitor Panes
The Monitor tab contains four panes:
Publications (top left) lists the publisher servers and the publications on each publisher that
need to be shared with the subscribers.
Subscriptions and Agents (top right) shows the subscriptions to a publication and the
replication agents associated with a publication. This pane has two tabs:
Subscriptions shows the subscriptions to the selected publication. Right-click on a
subscription to start or stop the subscription.
Agents shows the replication agents associated with the selected publication. Rightclick on a replication agent to start or stop the agent.
Sessions (bottom left) shows all sessions for the selected publication and replication agent in
the last 24 hours.
Actions (bottom right) shows the activity for the selected session. The status icons are:
Unknown
Running
Completed
Retry
Error
The information in the Monitor tab is refreshed every five seconds.
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Using Replication Manager
Starting Replication Manager
To start Replication Manager:
1.

Launch Integrated Configuration Environment (installed as part of Unified CCDM). In
the Database Connection dialog box, set:
Server Name. Enter the name of the primary database server.
Database Name. Enter the name of the Unified CCDM database that was installed
when setting up the Database Component. If you accepted the default value, this will
be Portal.
Authentication. Select Windows Authentication.

2.

Click OK. The ICE Cluster Configuration tool starts by default.

3.

In the Tools drop-down, select Replication Management. The Replication Manager tool is
displayed:
If SQL Server replication is not currently configured, the Replication Manager tool
starts in the Setup tab (see section "The Replication Manager Setup Tab").
If SQL Server replication is configured, the Replication Manager tool starts in the
Monitor tab (see section "The Replication Manager Monitor Tab").

Configuring Replication
To configure replication if replication is not running, in Replication Manager, select the Setup tab
and click Configure. This process may take several minutes. Once replication has been
configured, the Replication Manager automatically switches to the Monitor tab, which enables you
to monitor the replication process.

Disabling Replication
To disable replication if replication is currently running, in Replication Manager, select the Setup
tab and click Disable. This may take several minutes. When replication has been disabled, a
confirmation message is displayed.

Monitoring Replication
To monitor replication for a publication, in Replication Manager, select the Monitor tab and
select a publication in the top left pane. The subscriptions and replication agents associated with
the selected publication are listed in the top right pane in the respective tab.
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The Subscriptions tab shows all the subscriptions to the selected publication. It will help answer
the following questions
Which subscriptions are slow?
This will show the latency of replication from publisher to the subscriber.
Is the replication system healthy?
The grid will show status icons for warnings and error for subscriptions that require
attention.
The Agents tab displays the agents that are used by the selected publication. This tab shows the
following agents:
The Snapshot Agent is shown for all publications
The Log Reader Agent is shown for transactional publications Base and NonQueued.
The Queue Reader Agent is shown for transactional publication Base only.
You can use the Monitor tab to start and stop the Subscriptions and Replication Agents. In order to
start or stop, right-click on the selected subscription or agent and select Start or Stop.
You can view the session details for a Subscription or an Agent in the two bottom panes. Select
the Subscription or Agent in the top right pane. The bottom left pane shows all the sessions for the
selected Subscription or Agent in the last 24 hours. It shows the following details for each session:
Status - the current status of the session.
Start Time - when the session was started.
End Time - when the session stopped. This is set only for sessions that are not currently
running.
Duration - the total duration for each session.
The bottom right pane shows the SQL Server Replication actions performed for a replication
session. To see the actions for a replication session, select the replication session in the bottom
left pane.

Identifying Replication Errors
The Monitor helps to identify replication errors that have occurred in replication. If an error has
occurred in a particular subscription or an agent, the respective subscription or agent status icon
will show an error.
Select the subscription or agent that shows the error. Selecting the subscription or agent will show
their sessions. If an error occurred during a session, the session will show an error icon. Select the
session with the error to see the actions. The actions describes the nature of the error in the action
message.
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More about Replication
Performance Considerations
Each time the information in the Monitor tab refreshes, it requests data from the underlying
replication system. These additional requests may sometimes affect the overall performance of
SQL Server Replication, especially on busy systems. As a result it is recommended that the
Monitor should not be left running for long periods of time.
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Failover Manager
About Failover Manager
The Unified CCDM Failover Manager enables you to manually switch the Provisioning and Data
Import services between two fully operational servers in a dual-sided Unified CCDM installation.
Caution!
Only use the Unified CCDM Failover Manager to perform a planned manual failover, for
example to perform maintenance on one of the servers. The service to be switched must be
running and fully operational on both servers, and the data must have previously been
synchronized between the servers.
Do not use the Failover Manager to switch between servers in a disaster recovery scenario, for
example if one of the servers has failed or has corrupt data. If in doubt, please contact your
vendor support before continuing.

Using Failover Manager
Preparing to Use the Failover Manager
Before performing a failover for a service:
Be aware that the service will be unavailable during the failover, and that for a large
database, the failover may take a significant period of time.
Ensure that you have an up-to-date database backup.
Ensure that you are logged in as a domain level user who has administrative rights on both
servers, and also on the machine being used to run the ICE tool.
Ensure that the firewalls on both servers and on the machine being used to run the ICE tool
are configured as in the Network and Environment Configuration section of the Installation
and Configuration Guide for Cisco Unified Contact Center Domain Manager.

Starting the Failover Manager Tool
To start the Failover Manager tool:
1.

Launch Integrated Configuration Environment (installed as part of Unified CCDM). In
the Database Connection dialog box, set:
Server Name. Enter the name of the primary database server.
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Database Name. Enter the name of the Unified CCDM database that was installed
when setting up the Database Component. If you accepted the default value, this will
be Portal.
Authentication. Select Windows Authentication.
2.

Click OK. The ICE Cluster Configuration tool starts by default.

3.

In the Tools drop-down, select Failover Management. The Failover Manager tool is
displayed, showing:
the Unified CCDM service types that support failover
the service that is currently active for each
where available, the currently inactive service that can used for failover.

For each service type, the currently active service is shown as a depressed button, and identified
by [active]. The inactive service is shown as a raised button that can be clicked to select it (see
Figure 4.1 "Failover Management ICE Tool").
Note
This display simply indicates the active and inactive services that have been configured in your
Unified CCDM installation. It does not indicate the health of the services. Before performing a
failover, you should make sure that both services are fully operational.
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Failover Management ICE Tool

Performing a Failover Operation
To start a failover operation:
1.

In the Failover Manager tool, identify the service to be switched.

2.

Identify the service to be switched, and click on the raised button of the currently inactive
service to display the Manual Failover Wizard confirmation dialog box.

3.

If you want to restart the new active service when the failover completes (the default
option), select the Restart services when complete check box. If you do not want to restart
the new active service when the failover completes (for example, if you want to perform
other maintenance at the same time), clear the check box.
Caution!
Before continuing, make sure you really want to perform the failover at this time.
The process may take some time to complete, and once it starts, it cannot be interrupted.
During this time, neither the old active service nor the new active service will be available.
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4.

If you are sure you want to start the failover, click Next. The failover process may take
some time to complete. The Manual Failover Wizard dialog box shows the progress and
status for each step. A green tick means that the step completed successfully and a red cross
means that the step completed but there was an error which needs to be fixed before the
failover can continue.

5.

Once the wizard has finished, click Finished to return to the main Failover Manager screen.

6.

Confirm that the old service has stopped and the new service is running as follows:

7.

a.

In ICE, select the Service Manager tool.

b.

Verify that the old service has stopped. If not, select it and click Stop Selected.

c.

If you selected the Restart services when complete option for the failover, verify that
the new service has started, and, if not, select it and click Start Selected.

If the failover reported an error, then when the wizard finishes, neither the old service nor
the new service will be running. The error message will help you identify and fix the
problem and retry the failover, or you can restart the original active service. Contact your
vendor support if you need further help or advice.

More About Failover Manager
This section describes the failover actions for each of the Unified CCDM services.

Provisioning Service
Provisioning service failover has the following steps:
stop the provisioning service on the server on which it is currently running.
migrate the active token.
if requested, start the provisioning service on the new active server.

Data Import Service
Data import service failover has the following steps:
stop the data import server service on the server on which it is currently running.
migrate the active token.
if requested, start the data import server service on the new active server.
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Service Manager
About Service Manager
The Service Manager enables you to monitor, start and stop Unified CCDM services from a
central location.

Using Service Manager
Note
To use Service Manager to start and stop services you need to be logged in to Windows as a
domain user with permission to start and stop services.

Starting Service Manager
To start the Service Manager tool, perform the following steps on the primary database server:
1.

Launch Integrated Configuration Environment (installed as part of Unified CCDM). In
the Database Connection dialog box, set:
Server Name. Enter the name of the primary database server.
Database Name. Enter the name of the Unified CCDM database that was installed
when setting up the Database Component. If you accepted the default value, this will
be Portal.
Authentication. Select Windows Authentication.

2.

Click OK. The ICE Cluster Configuration tool starts by default.

3.

In the Tools drop-down, select Service Manager. The Service Manager tool is displayed,
showing a table of Unified CCDM services including the machine name they are installed
on, the service name and the current status (Running, Starting, Stopping or Stopped).

Starting Services
To start one or more Unified CCDM services, on the primary database server:
1.

In the Service Manager tool, click on the service or services you want to star. If you want to
start all or most of the services, you can select the All check box, then, if required, click on
any services you do not want to start. Select the All check box again to deselect all the
services in the list.

2.

Click Start Selected.
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A dialog box opens, reporting the status of each service as it is started. Click Close when
complete.

If a service is already started then no action is taken.

Stopping Services
To stop one or more Unified CCDM services, perform the following steps on the primary database
server:
1.

In the Service Manager tool, click anywhere on each service you want to stop. If you want
to stop all or most of the services, click Select/Deselect All, then, if required, click on any
services you do not want to stop. Click Select/Deselect All again to deselect all the services
in the list.

2.

Click Stop Selected.

3.

A dialogue box opens, reporting the status of each service as it is stopped. Click Close when
complete.

If a service is already stopped then no action is taken.

Restarting Services
To stop and restart one or more Unified CCDM services, perform the following steps on the
primary database server:
1.

In the Service Manager tool, click anywhere on each service you want to restart, to select
the service. If you want to restart all or most of the services, click Select All, then, if
required, click on any services you do not want to restart. Click Deselect All to deselect all
the services in the list.

2.

Click Restart Selected.

3.

A dialog box opens, reporting the status of each service as it is stopped and restarted. Click
Close when complete.

If a service is already stopped then it is just restarted.

Sorting Services
The Service Manager tool enables you to sort the Unified CCDM services by machine name,
service name or current service status. To do this, perform the following steps on the primary
database server:
1.

In the Service Manager tool, click the column heading of the column you want to sort on.
The list of services is sorted in ascending order according to the contents of that column.

2.

If you want to sort the services in descending order, click the column name again. The list of
services is displayed in descending order.
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Filtering Services
The Service Manager tool enables you to filter the list of services by machine name, service name
or service group.
Setting a Filter
1.

In the Service Manager tool, select the filter or filters you require:
To filter by machine name, start typing the machine name or part of the machine name
into the text box. The list of services is updated as you type, to show only those that
contain the letters you specify.
To filter by service name, select the arrow beside the text box to display the list of
available service names, and select the service name you want to filter by.
To filter by service group, select the arrow beside the text box to display the list of
available service names, and select the service group you want to filter by.

2.

The list of services is filtered according to the filter or filters you specified.

Clearing a Filter
To clear all the filters, select the
filters).

icon beside the filter boxes (only shown if you have set some

To clear an individual filter do one of the following:
To clear the filter for the machine name, delete the characters in the Machine Name text
box.
To clear the filter for the service name or service group, select the blank entry from the drop
down list.
Refreshing the Filtered List
To refresh the list of services, but retain the current filters, click Refresh.
Reloading the List of Services
To clear all filters and reload the servers and services from the database, click Reload.

Using the Shortcut Menu
Service Manager also has a shortcut menu. Right-click anywhere in the list of services to see a
shortcut menu with the following options:
Select/Deselect All
Start All
Stop All

Service Manager
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Stop Selected
Apply Filter
Clear Filter.
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System Properties Manager
About System Properties Manager
The System Properties Manager enables you to view and set Unified CCDM system properties.

Using System Properties Manager
Starting System Properties Manager
To open the System Properties Manager tool, perform the following steps on the server where the
properties need to modified.
1.

Launch Integrated Configuration Environment (installed as part of Unified CCDM). In
the Database Connection dialog box, set:
Server Name. Enter the name of the primary database server.
Database Name. Enter the name of the Unified CCDM database that was installed
when setting up the Database Component. If you accepted the default value, this will
be Portal.
Authentication. Select Windows Authentication.

2.

Click OK. The ICE Cluster Configuration tool starts by default.

3.

In the Tools drop-down, select System Properties Manager. The System Properties
Manager tool is displayed, showing the Unified CCDM properties, grouped by property type
and functionality.

The following property types are available:
Global properties (see section "Global Properties Tab")
Local properties (see section "Local Properties Tab")
Capacity properties (see section "Capacity Properties Tab").
When you first start the System Properties Manager from ICE, the display shows the global
properties. To see the other properties, click in the appropriate tab in the left hand pane.
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System Properties Reference
Global Properties Tab
The Global Properties tab enables you to view and configure system wide items and items that
affect multiple Unified CCDM components.
The properties are grouped as follows:
Active Directory Context Type. Specifies the type of store used to authenticate against.
The default value is set to Domain.
For more information about the options and what they mean, see the Microsoft .NET
documentation, http://msdn.microsoft.com/enus/library/system.directoryservices.accountmanagement.contexttype.aspx (checked July
2016).
Active Directory Password. The password used by Active Directory.
Active Directory User Name . The user name used by Active Directory.
Activity Monitor
This group specifies configuration information for the Activity Monitor. This group contains the
following properties:
Provisioning Warn Threshold. The number of seconds after which an item or membership
in the provisioning queue is shown in the middle (orange) band of the Activity Monitor.
Provisioning Max Threshold. The number of seconds after which an item or membership in
the provisioning queue is shown in the top (red) band of the Activity Monitor.
Code Lookup, supported equipment types
This group specifies information about equipment types. This group contains the following
property:
Code Lookup and Supported Equipment Types. The type of equipment that is used to
import codes into the Unified CCDM database. Currently the only supported value is CRT_
CICM (equipment type Cisco CICM)
Database Lock Configuration
This group specifies the timeout values used in the database for the importer and provisioning
services. This group contains the following properties:
Lock Importer Acquire Timeout. The time that the importer will wait to acquire a lock
before timing out. The setting is entered in hh:mm:ss format.
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Lock Importer Retry Rate. The number of times the importer service will try to gain a
lock on a database item before failing the item.
Lock Provisioning Acquire Timeout, The time that the provisioning service will wait to
acquire a lock before timing out. The setting is entered in the format hh:mm:ss.
Lock Provisioning Retry Rate. Controls the number of times the provisioning service will
attempt to gain a lock on a database item before failing the item.
Gadget Management
This group specifies the gadget management settings. This group contains the following properties:
Default Welcome Gadget. The GUID of the default gadget that is shown on the gadget
canvas if no App is selected. Set the value to “00000000-0000-0000-0000-000000000000” for
none. Do not set this value to any value other than “00000000-0000-0000-0000000000000000” without instruction from your vendor support.
Gadgets Cache Expiration Period. The time period in seconds after which a cached gadget
definition expires and is removed from the gadget cache. To disable the gadget cache during
gadget development, set this to zero. For normal production use, this should be set to a nonzero value.
Gadget File Path. The file path to a location on the web server where gadget files are
located (used during gadget development only). Each gadget file name must match the name
of the gadget it contains. If the gadget cache expiration period is zero, then Unified CCDM
will first look for gadget files in this location and only load a gadget from the database if the
gadget is not found here. For normal production use, this should be set to the empty string.
Importer State
This group specifies the import data settings. This group contains the following properties:
Bow Wave Duration Hours. The time period in hours relative to a cluster resource creation
date that constitutes the bow wave period. The value is between 1 and 24.
Bow Wave Effective From. The effective from date for dimensions created during a bow
wave.
Last Cluster Update. The date and time the cluster was last updated (read-only).
Local Login Security
This group specifies the way that Unified CCDM logins are authenticated. This group contains the
following properties:
Max Password Length. The maximum number of characters allowed in a password.
Min Password Length .The minimum number of characters allowed in a password.
Minimum Password Lifetime. The minimum number of days that a password can be used
for, before it is possible to change it.
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Password Expiry. The number of days before a password expires and has to be changed,
measured from the date that the password was last changed.
Password Format. The required password format. This field can also be set in the web
application using Settings > Security Settings > Password Format. If one of predefined
password formats (Low Security, Medium Security, Medium/High Security or High
Security) is chosen in the web application, this field is automatically populated with the
corresponding expression. This field is a .NET regular expression, except that the expression
{MIN_MAX} can also be used to specify that the password length must lie between the values
specified for Min Password Length and Max Password Length. For example, if Min
Password Length is 8 and Max Password Length is 20, then {MIN_MAX} is equivalent to
{8,20} in the .NET regular expression syntax.
Password Hash Algorithm. Specifies the algorithm for encoding user passwords. To
change the encoding of existing passwords, in the web application User Manager tool, set
User must change password at next login for each user. The default is set to SHA256.
Password History. The number of previous passwords that are saved and cannot be reused
when a user password is changed.
Password Reuse Time. The minimum number of days that must elapse before a previous
password can be reused.
User Lockout. The number of failed login attempts that a user is allowed before their
account is locked.
Login Authentication Configuration
This group specifies the way that Unified CCDM logins are authenticated. This group contains the
following properties:
Adfs Metadata Url: The Active Directory Federation Services metadata URL.
Credential Cache Expiration Period. Specifies the time in seconds that the user’s login is
cached before being re-authenticated. This re-authentication is internal, and not visible to the
user. Choose a longer cache expiry to reduce the traffic between the Unified CCDM
Web/App server and the authenticating server.
Credential Cache Expiration Type. Specifies the way in which the expiry period for reauthentications is determined. One of:
Absolute Expiry: the expiry period for re-authentication is measured from the last
authentication, whether or not the user has been active on the system since that time.
Sliding Expiry: the expiry period for re-authentication is measured from the last time
the user was active on the system, or from the last re-authentication, if that was later.
Disable Inactive User Accounts Time Period. Disable all non-system users that have not
logged into the application for a set time period. Default is set to 30 days,
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Enabled Login Types. Specifies which authentication modes can be used by the user to
login to the system. Multiple authentications can be used for the same user. The
authentications modes supported are:
Local.
Windows.
ADFS.
Ext Auto Create User. Creates a user for logins that were successfully authenticated
against an external provider. One of True or False.
External Signout. When you logout from the web application, you will also be logged out of
the identity provider. One of True or False. Defaults to True.
Media Upload
This group specifies the default behavior for uploading media. This group contains the following
properties:
Media File Accepted Formats. A comma separated list of file extensions that are valid for
media files.
Media Share. The network share name where WAV files uploaded through the Unified
CCDM user interface will be placed for replication to the CVP Media Server.
Miscellaneous
This group specifies some miscellaneous properties. This group contains the following properties:
Agent Description Field Mandatory. Whether the agent description field is mandatory
when agents are created and edited. One of True or False.
Agent Description Format. A regular expression defining the characters that are not
allowed in the agent description field. Special characters must be escaped. For example, if
you wanted to exclude the characters “z”, “&” and “*”, you would enter [z\&\*].
Delete Person With Last Agent Member. Determines if the associated person dimension
will be deleted when the last agent member is deleted.
Display Purge Button Stuck Seconds. The number of seconds to wait before determining
that an item in synchronizing or pending state is blocked. Once this time has been exceeded
a purge button is displayed in the web application.
Menu Items. Custom applications can be added to the menu bar by the inclusion of a display
name and URL. Items separated by a semi colon.
Product Name. The name of the product to display in the user interface, allowing
organizations to personalize the product.
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Prov Agent State Trace Enabled. Determines whether Resource Manager users can
enable the ICM State Trace feature on agents. ICM State Trace provides enhanced logging
information when individual agents move from one state to another.
Query Parameter Boundary. The maximum number of parameters in an SQL query before
a sub query is generated.
Resource Internal Name Create Enabled. Whether a resource internal name can be
created. One of True or False.
Resource Internal Name Edit Enabled. Whether a resource internal name can be edited.
One of True or False.
Show Only Reporting Timezones. Determines whether only timezones supported for
reporting re displayed in the web application, rather than all timezones.
Show Only UI Translation Cultures. Determines whether only cultures which have a UI
translation are displayed in the web application rather than all cultures.
Note
Non UI cultures are not fully supported. All unrecognized cultures will default the date format to
en-US.
Supported Languages. The culture codes for the languages supported by the installation.
Click the drop-down list to see and select the supported languages.
Supported Peripheral Types. The peripheral types that can be associated with resources
such as agents. Click the drop-down list to see and select the supported peripheral types.
Web Server Debug Info Disclosure. Whether server and culture information is shown in
the menu bar of the web application. One of True or False.
Other Security
This group specifies other security options. This group contains the following properties:
Enable User Copy. Determines whether the user copy feature is available in the Unified
CCDM web application. One of True or False.
Inherit Permissions Default. Determines whether the Inherit Permissions check box is
selected by default when a new folder is created. One of True or False.
Push Policy Changes to Child. Determines whether the Change Permissions for Subfolders
check box in Security Manager is selected by default when the user selects Change
Permissions. One of True or False.
Partitioning State
This group specifies database partitioning options. This group contains the following properties:
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Last Partition Metadata Change. The date and time that the partition metadata was last
updated (read-only).
Resource Management Properties
Resources Max Array Length. For the Resource Management Web Services API, the
maximum number of resource items that can be returned in the results array. The API will
report an error if the number of items to be returned exceeds this limit. Note that for the
REST GET, DELETE or PUT methods, the REST URL limit will normally be exceeded
first.
Resources Max Write Array Length. For the Resource Management Web Services API,
the maximum number of resources that can be created, updated or saved in a single API call.
System Limits
Max Dimension Associated Items. The maximum number of associated items that can be
listed for a dimension in the web application.
Max Dimension Drop Down List Items. The maximum number of dimension items that
can be shown in a drop-down list in the web application before the list is disabled.

User Provisioning
This group specifies the default behavior when creating users. This group contains the following
properties:
Create Advanced Users Groups. Determines if an advanced users group is created when a
folder is set to not inherit permissions. One of True or False.
Create Basic Users Groups. Determines if a basic users group is created when a folder is
set to not inherit permissions. One of True or False.
Create Supervisor Users Groups. Determines if a supervisor users group is created when
a folder is set to not inherit permissions. One of True or False.
Default Home Folder Role. The role that is automatically associated with a user on their
home folder when the home folder is created.
Default Tenant Administrators Global Role. The global role that is automatically
associated with the Administrators group when a new Tenant or policy root folder is created.
Default Tenant Administrators Role. The role that is automatically associated with the
Administrators group when a new Tenant or policy root folder is created.
Default Tenant Supervisors Global Role. The global role that is automatically associated
with the Supervisors group when a new Tenant or policy root folder is created.
Default Tenant Supervisors Role. The role that is automatically associated with the
Supervisors group when a new Tenant or policy root folder is created.
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Default Tenant Users Global Role. Specifies the global role that is automatically
associated with the Users group when a new Tenant or policy root folder is created.
Default Tenant Users Role. Specifies the role that is automatically associated with the
Users group when a new Tenant or policy root folder is created.
Home Folder Suffix. The suffix that is appended to the username when a home folder is
created for a user.

Local Properties Tab
The Local Properties tab enables you to view information from the local machine.
The properties are grouped as follows:
Checksum
This group displays database validity information. This group contains the following property:
Is Database Valid. The value determining whether or not the database is valid. (read-only).
Partitioning State
This group specifies partition table information. This group contains the following property:
Last Partition Tables Refresh. The date and time of the last partition table refresh (readonly).
Versioning Group
This group displays the following version numbers. This group contains the following properties:
Build Version. The build cycle that the installation was taken from (read-only).
Schema Version. The version of the database schema being used (read-only).

Capacity Properties Tab
The Capacity Properties tab enables you to view and configure the capacity rules for the remote
equipment. A capacity rule may apply to:
all equipment of a specified type in the cluster, or only to a specific equipment instance
all tenants in the cluster, or only to a specific tenant.
The properties of the capacity rules are determined by the remote equipment. The properties are
grouped by capacity rule. Each capacity rule has the following properties:
CapacityId. The database primary key of the capacity rule (read-only).
ItemType. The resource type that the capacity rule applies to (read-only).
MemberType. The membership that the capacity rule applies to, or <None> (read-only).
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ViaMemberType. The additional membership that the capacity rule applies to, or <None>
(read-only).
Description. The description of this capacity rule (read-only).
MaxCapacity. The maximum number of resources or memberships allowed under this
capacity rule. This value can be edited if the System property is False, or if the
ClusterInstance property is <All>. Otherwise this value is read-only.
ClusterType. The cluster type of the remote equipment that the capacity rule applies to
(read-only).
ClusterInstance. The remote equipment that the capacity rule applies to (read-only). One
of:
<All>, if the capacity rule applies to all instances of that equipment type
the specific cluster name of the remote equipment, if the capacity rule only applies to a
single instance of that equipment type.
TenantName. The tenant that the capacity rule applies to (read-only). One of:
<All>: if the capacity rule applies to all tenants on the specified equipment
the specific tenant name, if the capacity rule only applies to a single tenant on the
specified equipment.
CreationDate. The date that this capacity rule was created (read-only).
ModifiedDate. The date that this capacity rule was last modified (read-only).
System. Determines whether this the capacity rule is a default system value, or whether it
was added as a customization (read-only). One of:
True: the rule is a default system value
False: the rule is a customization.
Enabled Determines whether this capacity rule should be considered when creating a
resource or membership. One of True or False.

Gadget Provider Manager

Gadget Provider Manager
This feature is not supported.
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Custom Dimension Editor
About the Custom Dimension Editor
Description
The ICE Custom Dimension Editor enables you to create and edit custom dimensions.

Custom Dimensions
Custom dimensions are user-defined dimensions that store user data in Unified CCDM. This data
can be exported from the database, used in custom reports and also accessed programmatically
using the Unified CCDM Web Services APIs. Each item in a custom dimension can have freeformat attributes, defined as name-value pairs.
Unified CCDM provides ten custom dimensions, Custom0, Custom1, Custom2, . . . Custom9.
Each custom dimension can be used to store any number of items, and each item can have any
number of custom attributes. Each item in a custom dimension can have the same attributes, or
different items can have different attributes, depending on the requirements. The Custom
Dimension Editor does not check the attribute names or content, so it is up to the user to enforce
any rules that apply.

Using the Custom Dimension Editor
Starting the Custom Dimension Editor
To start the ICE Custom Dimension Editor:
1.

Launch Integrated Configuration Environment (installed as part of Unified CCDM). In
the Database Connection dialog box, set:
Server Name. Enter the name of the primary database server.
Database Name. Enter the name of the Unified CCDM database that was installed
when setting up the Database Component. If you accepted the default value, this will
be Portal.
Authentication. Select Windows Authentication.

2.

Click OK. The ICE Cluster Configuration tool starts by default.

3.

In the Tools drop-down, select Custom Dimension Editor. The Custom Dimension Editor is
displayed, showing Custom0 to Custom9 tabs and a grid listing the custom dimension items.
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Adding a Custom Dimension Item
To add a custom dimension item:
1.

Start the ICE Custom Dimension Editor (see section "Starting the Custom Dimension
Editor").

2.

Click the custom dimension corresponding to the item you want to add. For example to add a
new item to Custom2, click the Custom2 tab.

3.

In the grid, enter a name for the custom dimension item, and optionally, a description.

4.

To add attributes:
a.

In the attribute column, click Add (shown as Edit if the custom dimension item already
has one or more attributes).

b.

In the attributes dialog box, in the blank row, enter the name of the attribute and the
required value. All values are stored as strings.

c.

Add additional attribute rows as required. When you have finished adding attributes,
click OK to return to the Custom Dimension Editor.

Note
A custom dimension item cannot have two attributes with the same name. Unified CCDM does
not carry out any other validation on the attribute names or values, so if you require specific
attributes to be present, or for attributes to have a specific range of values, your must enforce this
yourself.
5.

To save and action your changes, either click the Save icon in the tool bar or select File >
Save from the menu. The custom dimension item is created in the /Shared folder in the
Unified CCDM folder tree.

Editing a custom dimension item
To edit a custom dimension item:
1.

Start the ICE Custom Dimension Editor (see section "Starting the Custom Dimension
Editor").

2.

Click the custom dimension tab that contains the item you want to edit.

3.

In the grid, locate the item you want to edit.
You can change the name or description of a custom dimension item directly in the
grid.
To edit the attributes, click Edit beside the item (or Add if the item has no attributes
yet) then make the required changes to the attributes.
You can change the name or value of an attribute directly in the grid.
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To add an attribute, in the blank row, enter the name of the attribute and the
required value. All values are stored as strings.
To delete an attribute, select the attribute row you want to delete, then press
Delete. You can select multiple rows to delete multiple attributes.
4.

When you have finished, click OK to return to the Custom Dimension Editor.

5.

To save and action your changes, either click the Save icon in the tool bar or select File >
Save from the menu.

Deleting a Custom Dimension Item
To delete a custom dimension item:
1.

Start the ICE Custom Dimension Editor(see section "Starting the Custom Dimension
Editor").

2.

Click the custom dimension tab that contains the item you want to delete.

3.

In the grid, select the check box beside the item or items you want to delete. You can click
Select All to select all items in the grid, or Select None to clear all the selections you have
made in the grid.

4.

When you have selected the item or items you want to delete, click Delete Selected.

5.

To save and action your changes, either click the Save icon in the tool bar or select File >
Save from the menu.

Tip
You can also use the classic Resource Manager in the Unified CCDM web application to delete
custom dimension items.

Moving a Custom Dimension Item
The Custom Dimension Editor creates all custom dimension items in the /Shared folder. You can
use the classic Resource Manager in the Web UI to move custom dimension items to other folders
if required. See the User Guide for Cisco Unified Contact Center Domain Manager or the on-line
help for more information.
The Custom Dimension Editor does not show the folder path of an item, and can only create items
in the /Shared folder. But if the item has been moved, the new location is retained when the item
is edited.

